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	Fundamentals of Computer
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1.	� A microprocessor is an integrated chip on which the entire CPU (Control Unit and ALU) is 
fabricated. 

2.	 Digital Camera and Microwave.

1.	 a. (i)	 b. (iv)	 c. (iv)	 d. (i)	 e. (iii)
2.	 a. Plotter	 b. Computer	 c. Control Unit	 d. Optical Character Reader
	 e. Smart Watch
3.	 a. (F)	 b. (T)	 c. (T)	 d. (T)	 e. (F)
4.	 a.	Magnetic Ink Character Reader is an input device that reads special characters that are 

printed using a special magnetic ink on cheques like Cheque number, bank code and branch 
code. MICRs scan this information and are thus capable of sorting cheques.

	 b.	Barcode reader is an electronic device, used for reading printed barcodes. Barcode readers 
consist of a light source, lens and light sensor that help them scan these codes.

	 c.	Fourth Generation computers used components like the microprocessor, where micro refers 
to the physical size of the component. A microprocessor is an integrated chip on which the 
entire CPU (Control Unit and ALU) is fabricated.

	 d.	A handheld computer is a type of computer that can easily be stored in our pocket and used 
by holding it in our hands. Most of handheld computers have a touchscreen in which we 
input data by using our fingers. Smartphone and Smartwatch are two examples of handheld 
computer.
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	 e. 	(i)	� A projector projects or displays data of computer screen on a large screen or surface for 
audience.

		  (ii)	� Automated Teller Machine (ATM) is another example of the embedded computer that 
allows us to withdraw money from our bank account from anywhere and anytime.

		  (iii)	� The microwave that we use at our home is also an example of the embedded computer 
that allows us to warm and cook food.

		  (iv)	� A laptop is a portable computer which you can keep on your lap. You can carry a laptop 
anywhere, therefore, you are not restricted to one place while working on a desktop 
computer.

5.

a. � Minicomputers are more powerful than 
microcomputers. They are bigger in size and 
faster in processing speed.

b. � They can support several users working at the 
same time on the same machine which means 
they support a multi-user environment.

c.  For example HCL Magnum

a. � A supercomputer consists of a large 
number of processors and also occupies 
a huge amount of space.

b. � They are used in the fields of creating 
animated graphics and conducting nuclear 
research.

c.  For example. PARAM 9000

Supercomputer Minicomputer

7. 	 a.	I	 b. I	 c. O	 d. O
	 e. I	 f. O
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	Formulas and Functions in Excel 2010

uiz Bee
Page-28

1.	 MAX(range)			   2.  Colon (:), Single space and Comma (,).fabricated. 

1.	 a. (ii)	 b. (i)	 c. (i)	 d. (i)	 e. (iv)
2.	 a. Label	 b. equal to	 c. cell reference	 d. function	 e. LEN
3.	 a.	A formula is an expression that operates on the value or a range of cells and generates a 

result.
	 b.	The results of the formula in a numerical formula, are calculated according to an order is 

known as the operator precedence.
	 c.	The syntax of this function is CONCATENATE (text1, text2). It is used to join together two or 

more different text strings
	 d.	A group of selected cells is called a cell range. The selected cells should be in continuation 

to form a range. Cell range is used to perform a calculation on multiple cells. 
		  To select a cell range using a mouse, click in the first cell from which you want to start the 

range, then press and hold the left mouse button and drag the mouse diagonally to select 
the desired range. Now release the mouse button.

	 e.

The function name is not recognised 
by Excel.

The cell reference is not valid.

The formula or function contains 
invalid numeric values.

#NAME?

#REF!

#NUM!

Check and correct  the 
function name.

Check and correct the cell 
ranges.

Ensure there are no special 
symbols such as $ or % being 
used with the number.

Error Meaning Tip to Correct

2.
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4.	 a.	Max(): It returns the largest value in the given range.
	 b.	Today(): It returns the current date.
	 c.	Len(): It returns the length of the text string.
5.	 a.

i. � It refers to the reference in a formula remains 
the same even if we copy and paste the 
formula to a new location.

ii. � For example, if we want the value of A1 to 
be constant, when multiplying it with cell of 
column B, absolute referencing will be used.

i. � It refers to the cell that is above or below 
and left or right to a number of rows or 
columns.

ii. � For example, a formula (=A2*B2) placed 
in cell C2 multiplies the values of cells A2 
and B2. As we press the Enter key, the 
result of the multiplication of values in 
A2 and B2 is displayed in cell C2.

Relative Cell Referencing Absolute Cell Referencing

	 b. 

i. � Reference operators are used to combine a 
range of cells.

ii. � Some reference operators are colon 
operator, comma operator.

i. � Comparison operators are used to 
compare two values with the given set 
of operators.

ii. � Some comparison operators are = 
(equal to), > (greater than).

Comparison Operators Reference Operators

COding Zone
COding Zone
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1.	 a. 50				   b. 3
2.	 a. =CONCATENATE(“Good “, “Morning”)		 b. =MIN(10,6,-2,0)
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	Charts in Excel 2016

uiz Bee
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Answer: Bar chart

1.	 a. (ii)	 b. (iii)	 c. (i)	 d. (iii)	 e. (ii)
2.	 a. Column	  b. Pie	 c. Column	 d. Area	 e. Scatter
3.	 a. (F)	 b. (F)	 c. (T)	 d. (T)	 e. (F)
4.	 a.	Data can be presented in an attractive way to attract the attention of readers.
	 b.	Legend: It is a key which displays the symbols or colours used in the chart. 
   		  Chart Area: It includes all objects and elements of a chart.
	 c.	A pie chart is shaped like a circle divided into slices, each slice showing the relative size of 

each value. The pie chart only displays one data series in the form of comparative charts. It 
is useful when you want to emphasise on a significant element.

	 d.	To change the background of the chart, follow the given steps:

		  1  Select the chart.

		  2  Click on the Format tab.

		  3  Click on the Format Selection command.

		  4  Click on the Fill section.

		  5  Click on the Picture or texture fill option button.
	 e.	A line chart is a type of graph that displays continuous data at regular intervals. It is generally 

used to highlight the changes that take place in a value through a specified period of time. 
It is also known as a frequency polygon.

	 f.	 To change the chart type, follow the given steps:

		  1  Select the chart and click on Design tab.

		  2  Click on the Change Chart Type command.

3.
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		  3  Click on desired option (here we choose Line option). The chart will change to Line Chart.

		  4  Click on Line with Markers option.
6.	 a. 60	 b. December	 c. October

COding Zone
COding Zone
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{} </>

1.	 27	 2. 24	 3. c

Periodic Assessment–1
(Based on chapters 1 to 3)

1.	 a.	Smart Watch is used as a computing device which you can wear on your wrist.
	 b.	Barcode Reader is used for reading printed barcodes.
2.	 a.	4	 b. 15	 c. 8	 d. 3
3.	 a. January	 b. October
4.	 a.	Chart	 b. Scatter Plot Chart	c. Today()	 d. ATM	
	 e.	Supercomputer

	 Introduction to Adobe Animate CC

uiz Bee
Page-54

1.	� A microprocessor is an integrated chip on which the entire CPU (Control Unit and ALU) is 
fabricated. 

2.	 Digital Camera and Microwave.

1.	 a. (ii)	 b. (i)	 c. (ii)	 d. (ii)	 e. (i)
2.	 a. Animation	 b. Library	 c. Frames	 d. Sub-Selection	 e. Lasso
3.	 a.	 Stage, Work Area and Current Scene (any three).

4.
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		  3  Click on desired option (here we choose Line option). The chart will change to Line Chart.

		  4  Click on Line with Markers option.
6.	 a. 60	 b. December	 c. October

COding Zone
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1.	 27	 2. 24	 3. c

Periodic Assessment–1
(Based on chapters 1 to 3)

1.	 a.	Smart Watch is used as a computing device which you can wear on your wrist.
	 b.	Barcode Reader is used for reading printed barcodes.
2.	 a.	4	 b. 15	 c. 8	 d. 3
3.	 a. January	 b. October
4.	 a.	Chart	 b. Scatter Plot Chart	c. Today()	 d. ATM	
	 e.	Supercomputer

	 Introduction to Adobe Animate CC

uiz Bee
Page-54

1.	� A microprocessor is an integrated chip on which the entire CPU (Control Unit and ALU) is 
fabricated. 

2.	 Digital Camera and Microwave.

1.	 a. (ii)	 b. (i)	 c. (ii)	 d. (ii)	 e. (i)
2.	 a. Animation	 b. Library	 c. Frames	 d. Sub-Selection	 e. Lasso
3.	 a.	 Stage, Work Area and Current Scene (any three).

4.

 

	 b. It organises and controls a document’s content in layers and frames. Like films, Animate 
documents divide time lengths into frames. The timings of animations are adjusted in the 
Timeline panel.

	 c.	To fill colours in a shape, follow the given steps:
		  1  Click on the Paint Bucket tool.
		  2 	 Click on the Fill Color button.
		  3 	 Select the desired colour.
		  4 	 Click inside the shape to fill colour.
	 d.	draw a curved line, follow the given steps:
		  1 	 Click on the Pen tool.
		  2 	 Click on the stage area from where the curve has to begin. An anchor point is created.
		  3 	� Position the mouse pointer and drag to set the slope of the curve. Now release the mouse 

button.
	 e.	To save an Animate file, follow the given steps:
		  1 	 Click on the File menu.
		  2 	 Click on the Save option.
		  3 	 Choose the location where you wish to save the file.
		  4 	 In the File name: box, type the file name.
		  5 	 Click on Save button.

COding Zone
COding Zone
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1.	 a. Gills	 b. Sky
2.	 a. G100	 b. D, W
3.	 9

	More on Adobe Animate CC

uiz Bee
Page-61

Answer: Label Text

5.
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1.	 a. (ii)	 b. (i)	 c. (ii)	 d. (iii)	 e. (iii)
2.	 a. (T)	 b. (T)	 c. (T)	 d. (F)	 e. (T)
3.	 a. .fla	 b. Lasso Tool	 c. Free Transformation Tool	 d. Ctrl+G
	 e. Label Text
4.	 a.	When text is added to Label Text, the text does not wrap. When text is added to Block Text, 

we specify a width and while typing the text, if it reaches the end of the block, it wraps to 
start a new line and increases the depth of the box.

	 b.	To select an object in a rectangular selection marquee by clicking and dragging over the 
object. To select an object, follow the given steps:

		  1 	Click on Selection tool.
		  2 	Place the mouse pointer and drag over the object you want to select.
	 c.	To rotate the object, follow the given steps:
		  1 	Select the object and click on the Free Transformation tool.
		  3 	�Move the mouse pointer just outside the corner of the object. The mouse pointer changes 

to 
		  3 	Click and drag to rotate.
	 d.	Yes. To group the shapes, follow the given steps:
		  1 	Select all the shapes one by one.
		  2 	Click on the Modify menu
		  3 	Select the Group option.
	 e.	To convert the text into a shape, follow the given steps:
		  1 	 Select the text to be converted and click on the Modify tab.
		  2 	 Click on the Break Apart command.
		  The text is converted into graphics as per selection.
	 f.	 We can change the font face and font size of the text from Properties inspector. To do so, 

follow these steps:
		  1 	 Select the text.	
		  2 	 Select the font face.
		  3 	 Select the font size.	
		  4 	 Select the Fill option.
		  5 	 Select the colour.	
		  6 	 Select spacing.
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1.	 a. (ii)	 b. (i)	 c. (ii)	 d. (iii)	 e. (iii)
2.	 a. (T)	 b. (T)	 c. (T)	 d. (F)	 e. (T)
3.	 a. .fla	 b. Lasso Tool	 c. Free Transformation Tool	 d. Ctrl+G
	 e. Label Text
4.	 a.	When text is added to Label Text, the text does not wrap. When text is added to Block Text, 

we specify a width and while typing the text, if it reaches the end of the block, it wraps to 
start a new line and increases the depth of the box.

	 b.	To select an object in a rectangular selection marquee by clicking and dragging over the 
object. To select an object, follow the given steps:

		  1 	Click on Selection tool.
		  2 	Place the mouse pointer and drag over the object you want to select.
	 c.	To rotate the object, follow the given steps:
		  1 	Select the object and click on the Free Transformation tool.
		  3 	�Move the mouse pointer just outside the corner of the object. The mouse pointer changes 

to 
		  3 	Click and drag to rotate.
	 d.	Yes. To group the shapes, follow the given steps:
		  1 	Select all the shapes one by one.
		  2 	Click on the Modify menu
		  3 	Select the Group option.
	 e.	To convert the text into a shape, follow the given steps:
		  1 	 Select the text to be converted and click on the Modify tab.
		  2 	 Click on the Break Apart command.
		  The text is converted into graphics as per selection.
	 f.	 We can change the font face and font size of the text from Properties inspector. To do so, 

follow these steps:
		  1 	 Select the text.	
		  2 	 Select the font face.
		  3 	 Select the font size.	
		  4 	 Select the Fill option.
		  5 	 Select the colour.	
		  6 	 Select spacing.

 COding Zone
COding Zone
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Periodic Assessment–2
(Based on chapters 4 & 5)

1.	

2.	 2 	 Go to import.

	 4 	 Navigate the location and select the image.

	 1 	 Click on the File menu.

	 3 	 Select the Import to Stage option.

	 a.	It draws and paints brush like strokes. It lets you create special effects.
	 b.	It is used to select irregular shaped pieces of an object.
	 c.	 It erases the area over which we drag the Eraser tool.
	 d.	It is used to select partial objects.



Trackpad (Version 1.0)-VI (Answer Key)10

Test Sheet–1
(Based on chapters 1 to 5)

1.	 a.	(iii)	 b. (iv)	 c. (iii)	 d. (ii)	 e. (i)
	 f.	 (ii)
2.	 a.	Control unit	 b. Optical Character Reader	 c. function	 d. LEN()
	 e. equals to	 f. Bar		  g. Bar
3.	 a. (F)	 b. (T)	 c. (T)	 d. (T)	 e. (T)
	 f.	 (T)
4.	 a.	Barcode reader or barcode scanner is an electronic device, used for reading 

printed barcodes.
	 b.	The results of the formula in a numerical formula, are calculated according to an order is 

known as the operator precedence.
	 c. 	A formula is an expression that operates on the value or a range of cells and generates a 

result.
	 d.	(Any 2)
		  Legend: It is a key which displays the symbols or colours used in the chart. 
		  Chart Area: It includes all objects and elements of a chart.
	 e.	It organises and controls a document’s content in layers and frames. Like films, Animate 

documents divide time lengths into frames.
	 f.	 The Selection tool allows us to select an object in a rectangular selection marquee by clicking 

and dragging over the object.
5.	 a.	 A handheld computer is a type of computer that can easily be stored in our pocket and used 

by holding it in our hands. Most of handheld computers have a touchscreen in which we 
input data by using our fingers. Smartphone and Smartwatch are two examples of handheld 
computer.

	 b. A group of selected cells is called a cell range. The selected cells should be in continuation 
to form a range. Cell range is used to perform a calculation on multiple cells. 

		  To select a cell range using a mouse, click in the first cell from which you want to start the 
range, then press and hold the left mouse button and drag the mouse diagonally to select 
the desired range. Now release the mouse button.

	 c.	To save an Animate file, follow the given steps:
		  1 	 Click on the File menu.
		  2 	 Click on the Save option.
		  3 	 Choose the location where you wish to save the file.
		  4 	 In the File name: box, type the file name.
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		  5 	 Click on Save button.
	 d.	To change the background of the chart, follow the given steps:
		  1 	 Select the chart.
		  2 	 Click on the Format tab.
		  3 	 Click on the Format Selection command.
		  4 	 Click on the Fill section.
		  5 	 Click on the Picture or texture fill option button.
	 e.	To change the chart type, follow the given steps:
		  1 	 Select the chart and click on Design tab.
		  2 	 Click on the Change Chart Type command.
		  3 	 Click on desired option (here we choose Line option). The chart will change to Line Chart.
	 f.	 We can change the font face and font size of the text from Properties inspector. To do so, 

follow these steps:
		  1 	 Select the text.	
		  2 	 Select the font face.
		  3 	 Select the font size.	
		  4 	 Select the Fill option.
		  5 	 Select the colour.	
		  6 	 Select spacing.

	Learn HTML5 and CSS3

uiz Bee
Page-78

Answer: Empty tags are self-contained. They have only an opening tag. For example: <BR>.

1.	 a. (ii)	 b. (i)	 c. (iii)	 d. (i)	 e. (i)
2.	 a. HTML	 b. Hypertext	 c. External 	 d. Comments	 e. <HTML>
3.	 a. Notepad	 b. <P>	 c. Tim Berners Lee	 d. Cascading Style Sheets

6.
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4.	 a.	 Markup language is a computer language that uses specific codes for formatting the layout 
and style of a text file. It is human-readable, which means that markup files use the standard 
English language rather than the programming syntax.

	 b.	HTML is not a case sensitive language
	 c.	Container tags come in pairs, i.e. they have both opening and closing tags. The closing tag 

is created by putting a forward slash (/) at the beginning of the opening tag. For example, 
<HTML> …………… </HTML> 

	 d,	<TAGNAME STYLE = “PROPERTY1:VALUE; PROPERTY2:VALUE; PROPERTY3:VALUE;”>
	 e.	Cascading Style Sheets or CSS are used to define styles for webpages. 
		  An inline style is used to apply a unique style for a single element. Inline styles are added 

directly to an HTML tag by using the style attribute with the tag. Syntax to use the style 
attribute with a tag: 

		  <TAGNAME STYLE = “PROPERTY:VALUE;”>
	 f.	 The <HR> tag is used to divide the webpage into different sections by drawing a horizontal 

line in the webpage. The thickness of the horizontal line is specified through the Size attribute 
and the length is specified through the Width attribute in pixels or as a percentage..

	 For Example:
	 	 <!DOCTYPE HTML> 

		  <HTML> 

		  <HEAD> 

		  <TITLE> HR Tag </Title> 

		  </HEAD> 

		  <BODY> 

		  <p>This is the first paragraph of the tag. HTML is the standard markup 
language for Web pages. </p> 

		  <hr Size=”10” width=”80%” > 

		  <p>This is the second paragraph of the tag.HTML is the standard markup 
language for Web pages.</p> 

		  <hr Size=”10” width=”80%” color=”grey”> 

		  <hr Size=”10” width=”80%” color=”Red”> 

		  </BODY> 

		  </HTML>

	 g.	By default, all the text we type in an HTML document appears in one line. We can insert a line 
break to shift the text to go to a new line. The <BR> tag is used to insert a line break in an 
HTML document. <BR> tag is an empty tag and does not require a corresponding closing 
tag.

		  <!DOCTYPE HTML>
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		  <HTML>

			   <HEAD>

				    <TITLE> BR Tag </Title>

			   <HEAD>

			   <BODY>

			   <P>

			   Orange Education Pvt Ltd<BR>

			   9, Daryaganj<BR>

			   Delhi<BR>

			   110002

			   </P>

			   </BODY>

		  </HTML>

5.	

i. � External CSS allows us to define the style for 
many webpages by using a single CSS file.

ii. � You need to include a reference to the external 
style sheet file within the <LINK> element 
inside the <HEAD> element.

iii.  For Example: 
<HEAD> 
<LINK REL=“STYLESHEET” 
TYPE=“TEXT/CSS” HREF=“NAME OF 
STYLE SHEET”> 
</HEAD>

i. � Internal CSS allows us to define the style 
for a single HTML page.

�ii. � It is defined using the <STYLE> tag in the 
head section of the HTML page.

iii.  For Example: 
<HEAD> 
<STYLE> 
H1 {COLOR:RED;} 
H1 {COLOR:GREEN;} 
</STYLE>
</HEAD>

Internal CSS External CSS

COding Zone
COding Zone
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a.	 <HTML> is missing.		
b.	 </HTML> is missing.
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	Formatting a Webpage

uiz Bee
Page-87

Answer: text-align

1.	 a.	(i)	 b. (iii)	 c. (ii)	 d. (iv)	 e. (iii)
	 f.	 (i)
2.	 a. (F)	 b. (T)	 c. (T)	 d. (T)	 e. (F)
3.	 a.	Cascading Style Sheets (CSS) is a convenient method of styling the elements of a webpage. 

It controls various elements like the colour, font, text size, etc. within a single page or the 
entire website. CSS can also be used to change the look of any webpage elements such as 
paragraphs, lists, backgrounds, etc.

	 b.	Text-indent is the option which is used for indentation in HTML5. 
	 c.	 It is used for specifying the repetition of an image on the webpage.
	 d.	The margin property is used to set margins for any webpage element. The four sides used 

with the margin property are: left, right, top and bottom. The value of sides can be measured 
in pixels (for example: 20px, 30px, etc.) or as a percentage of the window.

	 e.	Every web page on a website can be linked to a single style sheet, hence, any change made to 
the style sheet formatting affects every HTML document linked to the sheet. We can use a style 
sheet as a template by storing all the information in one place and easily change the appearance 
of our site in one go, thus saving a lot of time in case your site has numerous pages.

	 f.	 i.	� Background-color: It contains the name of the colour. It specifies the background colour 
to be used on the webpage.

		  ii.	� Text transform: It specifies the transformation of text into uppercase, lowercase or title 
case.

COding Zone
COding Zone
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	 1

7.
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	Formatting a Webpage

uiz Bee
Page-87

Answer: text-align

1.	 a.	(i)	 b. (iii)	 c. (ii)	 d. (iv)	 e. (iii)
	 f.	 (i)
2.	 a. (F)	 b. (T)	 c. (T)	 d. (T)	 e. (F)
3.	 a.	Cascading Style Sheets (CSS) is a convenient method of styling the elements of a webpage. 

It controls various elements like the colour, font, text size, etc. within a single page or the 
entire website. CSS can also be used to change the look of any webpage elements such as 
paragraphs, lists, backgrounds, etc.

	 b.	Text-indent is the option which is used for indentation in HTML5. 
	 c.	 It is used for specifying the repetition of an image on the webpage.
	 d.	The margin property is used to set margins for any webpage element. The four sides used 

with the margin property are: left, right, top and bottom. The value of sides can be measured 
in pixels (for example: 20px, 30px, etc.) or as a percentage of the window.

	 e.	Every web page on a website can be linked to a single style sheet, hence, any change made to 
the style sheet formatting affects every HTML document linked to the sheet. We can use a style 
sheet as a template by storing all the information in one place and easily change the appearance 
of our site in one go, thus saving a lot of time in case your site has numerous pages.

	 f.	 i.	� Background-color: It contains the name of the colour. It specifies the background colour 
to be used on the webpage.

		  ii.	� Text transform: It specifies the transformation of text into uppercase, lowercase or title 
case.
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	 1

7.

 

	 Internet Services

uiz Bee
Page-98

Answer: Google Meet and Zoom

1.	 a. (i)	 b. (iv)	 c. (i)	 d. (ii)
2.	 a. Instant Messaging	 b. Google Drive	 c. Blogging	 d. Internet 

Banking
3.	 a. Google Meet	 b. Flipkart	 c. iTunes	 d. Facebook Messenger
4.	 a.	Zoom is used as a video conference application which is basically live meeting held between 

two or more geographically separated people. Each participant requires a video camera, a 
microphone, speakers and a high-speed Internet connection to transmit audio and video 
data.

	 b.	Instant messaging allows us to exchange messages (text, picture, etc.) between two or more 
people at different locations connected to the Internet. It allows us to create a group that 
may consist of friends, family or people at work, with whom we can chat privately.

	 c.	Online transactions can be made without going to the bank and at any time of the day.
	 d.	A Blog or Weblog is a personal online diary or journal that allows us to share our thoughts 

or ideas. A blog allows us to connect with people with similar interests. We can add videos, 
pictures and music to our blog and visitors can add comments on the published content too.

	 e.	A podcast is like an online on-demand radio show. It can be considered as a medium through 
which recorded audio information is distributed over the Internet, unlike a radio show where 
the show is broadcasted live. We can listen to these audio files whenever we want. You can 
listen to podcasts directly from the websites they are posted on or can also subscribe to them 
using software like iPodder and iTunes.

	 f.	 To upload a file/folder on Google Drive, follow the given steps:	
		  1 	 Click on the New option.
		  2 	 Click on Folder and select File upload or Folder upload option.
		  3 	 Navigate the folder and select the desired files or folders.
		  4 	 Click on Open button.

8.
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1.	 48
2.	 A B C D E F

Periodic Assessment–3
(Based on chapters 6 to 8)

1.	 a. Color	 b. background-color	 c. text-align	
	 d.	Hypertext 	 e. <Title>
2.	 <HTML>

	 <HEAD>

	 <TITLE> Solar System </TITLE>

	 </HEAD>

	 <BODY>

	 <FONT COLOR="red"> <H3 ALIGN="Center">Solar System</H3> </FONT> 

	 <P> <B> The Solar System </B>is the <B><I>gravitationally bound</I> 
</B><BR>

	 system of the Sun and the objects that orbit it, <BR>

	 either directly or indirectly.</P>

	 </BODY>

	 </HTML>

	 a. Video Conference: Video conference is a live meeting held between two or more 
geographically separated people. Each participant requires a video camera, a microphone, 
speakers and a high-speed Internet connection to transmit audio and video data.

	 b. Google Drive: Google Drive is a cloud storage service developed by Google. It provides up 
to 15 GB free safe storage space. We can store data online so that it can be accessed from 
anywhere. It also provides tools for sharing with other users easily over the Internet.

	 c. Instant Messaging: Instant messaging allows us to exchange messages (text, picture, etc.) 
between two or more people at different locations connected to the Internet. It allows us to 
create a group that may consist of friends, family or people at work, with whom we can chat 
privately.
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	Algorithm, Flowchart and Mind Maps

uiz Bee
Page-110

Answer: Low-level language

1.	 a. (i)	 b. (iii)	 c. (iii)	 d. (i)
2.	 a. (F)	 b. (F)	 c. (F)	 d. (F)	 e. (F)
3.	 a.	A flowchart is the graphical representation of a process and the logic (which is also called an 

algorithm) used in it. Flowcharts are used in analysing, designing, documenting or managing 
a process or program in various fields.

	 b. Definiteness: All instructions given should be clear and easy to understand. 
		  Finiteness: It should include a finite number of instructions for completing a task.
		  (Any 2)
	 c.	High-level language is considered to be closer to human beings. It is machine independent. 

However, they need to be translated into binary or machine language. Some examples are 
PASCAL, FORTRAN, etc.

	 d. An interpreter reads one line of instruction at a time and translates it into machine language.
		  A compiler reads an entire set of instructions written in a high-level language and then 

translates them into machine language.
	 e.	(Any three)

Input/Output: It represents reading input or writing output.

Processing: It indicates the processing of the input provided.

Decision: If there is a choice to be made between two options, 
this symbol is used. It has two flow lines outwards, representing 
Yes or No and True or False.

Symbol Description

9.
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COding Zone
COding Zone

COding Zone COding Zone{C ding z ne} []=
{} </>

Following is an algorithm to accept the age of a person and check whether he/she is eligible to vote 
or not. A person can only vote if he/she is 18 years old or more. Number the steps of the algorithm 
in the correct order.
2 	 Accept the age of the person.			   5   Stop.

3 	 If age is greater than or equal to 18, then display, ‘You are eligible to vote’.

1 	 Start.	

4 	 If age is less than 18, then display, ‘You are not eligible to vote’.

	 Introduction to Python

uiz Bee
Page-120

Answer: 1. T		  2. F

1.	 a. (iv)	 b. (i)	 c. (ii)	 d. (iv)	 e. (ii)
2.	 a. data type	 b. string	 c. input()	 d. Guido van Rossum
	 e.	Interactive Mode
3.	 a.	Python is a high level object-oriented programming language. It is a general purpose language 

with interactive features.
	 b.	Comments in Python can be used to explain parts of the code. It can also be used to hide 

the code as well. Python does not execute comments.	
	 c.	A data type is used to define the type of value a variable can contain. For example, a person’s 

name must be stored as a string value whereas the person’s age must be stored as an integer.
	 d.	Operators are the special symbols which are used to perform computations. The values which 

the operators use to get the output are called operands.

10.
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	 e.	(Any 2)
		  Open source: Python is an open-source language and can be easily downloaded from the 

Internet for free. 
		  Portable: Programs written in Python can run on almost every known platform such as 

Windows, Linux and Macintosh.
	 f. To open Python IDLE Shell, follow the given steps:
		  1 	 Type python in search box.
		  2 	 Click on IDLE (Python 3.9 64-bit) option.
	 Components
		  Menu bar: It has various menus such as File, Edit, Shell. 
		  Command Prompt: It allows the user to enter commands directly into Python and get an 

output instantly by pressing the Enter key. 
		  Control buttons: These buttons are used to resize and close the window.
	 g.	A Variable is the name of memory location that is used to store data values which can be 

accessed or changed later. The names given to the variables are known as identifiers.
		  In Python, variables are declared and initialized at the same time in the following way: 
	 	 a = 10 

		  b = 20 

		  print (“a=”, a) 

		  print (“b=”, b) 

		  On the output screen, a = 10 and b = 20 will be printed.
	 h.	To run a Python program, follow the given steps:
		  1 	Click on the run menu.
		  2 	Click on the Run Module option.
4.	 a. 

i. � It is also known as Editor’s Window.

ii. � It does not allow you to save our commands 
written on the command prompt, it gives 
output immediately after pressing the Enter 
key.

i. � It is also known as IDLE Shell Window.

�ii. � It is an interactive window where we can 
type a Python code and view the output 
in the same window.

Interactive Mode Script Mode
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	 b.

i. � We use the print() function to display the 
result on the screen.

ii. � The general syntax of the print() function is 
as follows: 

   type print(“message to be displayed”)

i. � We use input() function to take the user’s 
input while a program executes.

�ii. � The general syntax of the input() 
function is as follows: 

   �Variable_name = input(<message to be 
displayed>)

Input() Function Print() Function

6.	 a.	461	 b. -3	 c. 16122	 d. 113	 e. 2256

COding Zone
COding Zone

COding Zone COding Zone{C ding z ne} []=
{} </>

a. 38			  b. Son	 c. 19

	 Intelligence and AI Approaches

uiz Bee
Page-131

People who possess good understanding of musical rhythm and good at recognising the musical 
patterns and tones easily.

1.	 a. (iv)	 b. (ii)	 c. (i)	 d. (ii)
2.	 a. a. (T)	 b. (F)	 c. (T)	 d. (T)
3.	 a. Bodily-Kinesthetic Intelligence is being good at dancing and sports along with love creating 

things with their hands, tends to remember by doing, rather than hearing and seeing, and 
excellent hand-eye and physical coordination Flexible in different body movements and 
performing actions.

	 b. A rule-based system uses rules as knowledge representation. These rules are coded in the 
system in the form of if-then-else statements which help the computer in taking decisions. The 

11.
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11.

 

idea behind a rule-based system is to use the knowledge of a human expert in a specialised 
domain and embody it within the computer system.

	 c.	 Intelligence refers to the ability to think, to learn from previous experience, to solve complex 
problems and to adapt new things and environment.

		  Types of Intelligence:
		  ●	 Virtual-Spatial Intelligence
		  ●	 Verbal-Linguistics Intelligence
		  ●	 Logical-Mathematical Intelligence
		  ●	 Bodily-Kinesthetics Intelligence
		  ●	 Musical Intelligence
		  ●	 Interpersonal Intelligence
		  ●	 Existential Intelligence
		  ●	 Intrapersonal Intelligence
		  ●	 Naturalistic Intelligence
	 d. 82	 e. 141	 f. Plant
4.	

i. � Can recognise their strengths and weaknesses.

ii. � Aware of their own emotional state and feelings 
and know how they can motivate themselves.

iii.  Enjoy analysing theories and ideas. 

i. � Good at communicating ideas and 
thoughts.

�ii. � Good at non-verbal communication and  
resolving conflict in groups.

iii. � Good at maintaining positive relationships 
with others,

Interpersonal Intelligence Intrapersonal Intelligence

COding Zone
COding Zone

COding Zone COding Zone{C ding z ne} []=
{} </>

a.	 E       T        A		  b.  O     N       W

T A

E A T

A E

W O N

O

O W N
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Periodic Assessment–4
(Based on chapters 9 to 11)

1.	 a. Input box	 b. Processing box	 c. Output box
2.	 HTML Code
3.	 a. Bodily-Kinesthetic Intelligence	 b. Logical-Mathematical Intelligence

Test Sheet–2
(Based on chapters 6 to 11)

1.	 a. (iii)	 b. (i)	 c. (ii)	 d. (i)	 e. (iv)
	 f. (i)	 g. (ii)	 h. (i)
2.	 a. Algorithm	 b. Assembler	 c. External	 d. Identifiers	
	 e. Script Mode	 f. Internet Banking
3.	 a. (F)	 b. (F)	 c. (T)	 d. (F)	 e. (T)
4.	 a. A flowchart is the graphical representation of a process and the logic (which is also called an 

algorithm) used in it.
	 b.	Markup language is a computer language that uses specific codes for formatting the layout 

and style of a text file.
	 c.	Python is a high level object-oriented programming language. It is a general purpose language 

with interactive features.
	 d.	Zoom offers the video conferencing option which is a live meeting held between two or more 

geographically separated people.
	 e.	People who possess the qualities like being good at dancing and excellent hand-eye and 

physical coordination.
5.	 a.	An interpreter reads one line of instruction at a time and translates it into machine language. 

Any error in the instruction is reported immediately and the programmer can correct it 
accordingly. It is slower than the compiler.

	 b. The <HR> tag is used to divide the webpage into different sections by drawing a horizontal 
line in the webpage. The thickness of the horizontal line is specified through the Size attribute 
and the length is specified through the Width attribute in pixels or as a percentage. The 
Color attribute is used to set the colour of the rule. The Noshade attribute makes the line 
appear flat grey, giving a 2D effect to the rule.

	 c.	A Variable is the name of memory location that is used to store data values which can be 
accessed or changed later. The names given to the variables are known as identifiers. In 
Python, we do not need to specify the type of variable because Python is a dynamically 
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language and it also identifies the variable type automatically.
		  In Python, variables are declared and initialized at the same time in the following way: 
		  a = 10 

		  b = 20 

		  print (“a=”, a) 

		  print (“b=”, b) 

		  On the output screen, a = 10 and b = 20 will be printed.
	 d.	To open Python IDLE Shell, follow the given steps:
		  1 	 Type python in search box.
		  2 	 Click on IDLE (Python 3.9 64-bit) option.
	 Components
		  Menu bar: It has various menus such as File, Edit, Shell. 
		  Command Prompt: It allows the user to enter commands directly into Python and get an 

output instantly by pressing the Enter key. 
		  Control buttons: These buttons are used to resize and close the window.
	 e.	To upload a file/folder on Google Drive, follow the given steps:
		  1 	 Click on the New option.
		  2 	 Click on Folder and select File upload or Folder upload option.
		  3 	 Navigate the folder and select the desired files or folders.
		  4 	 Click on Open button.

	 f.	 Plant. Visual-Spatial Intelligence




